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Abstract 

 

Isolating Lithologic Controls on Landscape Morphology in the 

Guadalupe Mountains, New Mexico and Texas 

 

Emily Bradshaw Marino, M.S. Geo. Sci. 

The University of Texas at Austin, 2017 

 

Supervisor:  Joel Johnson 

 

In many geomorphic studies, lithologic contrasts are often acknowledged as 

important for landscape form, but are otherwise ignored in attempts to infer tectonic forcing 

or climatic control from topography. It remains difficult to separate the effects of tectonics, 

climate, and lithology due to the limitations of commonly used landscape evolution 

models. Tectonic inactivity and relatively little spatial variability in climate make the 

Guadalupe Mountains of Texas and New Mexico an ideal site to isolate and investigate the 

effects of lithology on topography.  

To assess the control of lithology, I compared topographic metrics including 

channel steepness index, channel concavity, and topographic relief in different mapped 

lithologic units across the region. Topographic metrics were calculated using elevation data 

extracted from USGS 10m Digital Elevation Models. These metrics were grouped spatially 

based on 23 regionally mapped lithologic units, including abundant limestone and dolomite 

with some evaporites, sandstone, and shale. To better evaluate the different rock units, I 

used published unit descriptions to develop a simple, semi-quantitative system to estimate 
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the relative durability rating (RDR) of each rock unit. This rating system accounts for rock 

type and other rock properties such as relative bed thicknesses or spatial heterogeneity.  

RDR values were found to be correlated with unit-averaged channel steepness for 

each of the 23 lithologies in the region. Channel steepness shows a moderate correlation 

with RDR (R2 = 0.44; Kendall’s τ = 0.52), demonstrating quantifiable control on landscape 

form. However, concavity does not show a significant correlation (R2 = 0.016; Kendall’s τ 

= 0.13). Stratigraphic relationships among units suggest that thick, resistant reef deposits 

exert the main lithologic control on overall channel forms in the region. Less resistant units 

stratigraphically below these reef deposits generally have higher than expected steepness 

given their RDR. Units at the bottom typically have high concavity values as well. The 

opposite is true for weaker units stratigraphically above the resistant reef formations, which 

have lower steepness and higher convexity. The contrasting influence of strong units above 

or below weaker units and their observed effects on channel form should improve our 

ability to infer rock properties from topography, and to predict the evolution of landscapes 

with lithologic variability.   
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INTRODUCTION 

Iconic landscapes of the American Southwest, with towering cliffs rising out of the 

surrounding desert, display clear examples of lithologic control. Horizontal layers of rocks 

are stacked atop one another in these arid and semi-arid settings, resulting in contrasting 

morphologies: steep cliffs as described above, as well as more gentle hillslopes, both 

influenced by bedrock strength and other rock properties (Figure 1).  The various processes 

and controls that shape the landscape are often studied through the examination of rivers 

and streams and though channels only account for a small percentage of the land surface, 

they serve as a key boundary condition for hillslope erosion, setting the relief structure and 

ultimately controlling denudation rates through incision (Whipple and Tucker, 1999; Kirby 

et al., 2003; Whipple, 2004).  The morphology of bedrock channels is especially important, 

as changes in the shape of longitudinal stream elevation profiles carry crucial information 

concerning climatic, tectonic, and lithologic variations (Whipple and Tucker 1999; Snyder 

et al., 2000; Perron and Royden, 2013). Streams in steady state are expected to demonstrate 

concave-up morphologies (Snyder et al. 2000; Whipple, 2004); however, changes in the 

long profile are often manifested as knickpoints, knickzones, or convex reaches (Pederson 

and Tressler, 2012).  Generally, these deviations can represent adjustments from tectonic 

or climatic fluctuations, base-level drop, or contrasts in rock strength (Duvall et al., 2004; 

Hilley and Arrowsmith, 2008; Berlin and Anderson, 2009). However, it remains difficult 

to separate the effects of the various feedbacks due to the limitations of models most 

commonly used.  Equations used to quantify these changes in channel form are most 

commonly derived from the Shear-stress/Stream power erosion model (Sklar and Dietrich, 

1998; Whipple and Tucker, 1999; Lague, 2014), which serves to simplify complex 

relationships and feedbacks into a model that can be easily applied and tested.  
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Figure 1. Photographs from the Guadalupe Mountains showing the variety of cliff faces 

and hillslopes in the region. Photo (a) is more representative of the lower relief 
topography in the north, where the other photos (b, c, and d) are representative of 
the higher relief topography in the central and southern regions. Photo (b) shows El 
Capitan. 

a. 

b. c.

d. 
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The stream power erosion model is a semi-empirical set of equations widely used 

to predict erosion rates and patterns along bedrock channels. With increasing access to 

digital topographic information, these equations have been used broadly for a variety of 

geomorphic studies. Examples of its applications include mapping river incision rates and 

inferring uplift patterns (Wobus et al, 2006; Kirby and Whipple, 2012), modeling 

knickpoint migration (Crosby and Whipple, 2006; Berlin and Anderson, 2009), and using 

it in landscape evolution studies and numerical models (Stock and Montgomery, 1999; Han 

et al., 2015; Forte et al, 2016).  Though this model is widely applied, it is simplistic and 

lacks sensitivity to account for complex tectonic, climatic, and lithologic variability 

(Whipple and Tucker, 1999; Lague, 2014). It remains difficult to separate these effects and 

many studies have avoided addressing this issue by isolating variables of interest. For 

example, lithologic contrasts are often acknowledged as important, but by focusing on 

environments without variable lithologies, studies can better determine the effects of 

tectonic forcing (e.g. DiBiase et al., 2012) or climatic control (Moon et al., 2011; Chadwick 

et al., 2013; Murphy et al., 2016). Isolating variables in this way successfully removes 

complicating effects, but even in seemingly homogeneous lithologies, there can be 

variations in erodibility across the landscape (Snyder et al., 2000; Small et al., 2015). 

Ignoring lithology also overlooks the possible influence of stratigraphic lithologic 

contrasts, which could impact both channel and hillslope form. 

The importance of lithologic control has been evident since early geomorphic 

studies (Gilbert, 1877). Hack’s (1975) model of dynamic equilibrium balanced erosional 

and resistive forces over time and through this, he recognized that areas of resistant rock 

typically had steeper slopes and relief than softer, more erodible rock units. Transitioning 

across multiple rock types within channels has also been shown to significantly affect 

overall channel form in some landscapes, often resulting in convex reaches and again 
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with generally higher steepness values for stronger lithologic units (Duvall et al., 2004; 

Jansen et al., 2010; Pike et al., 2010; Goode et al., 2010). Bursztyn et al. (2015) found a 

correlation between measured rock tensile strength and river gradient (R2 = 0.51), as well 

as a significant power-law correlation between reach-averaged unit strength and stream 

unit power (R2 = 0.60). The effects of lithology and bedrock strength are not only limited 

to channels. For example, Hurst et al. (2013) show that increased incision rates due to 

uplift, result in varying hillslope morphologies for different lithologies in the Sierra 

Nevada range. The granodiorite hillslopes display a shape similar to model predictions of 

steady state hillslope morphology, suggesting rapid adjustment to incision. However, 

hillslopes underlain by metavolcanic rocks display high gradients with lower hilltop 

curvature, indicating slower adjustment to incision. Johnstone and Hilley (2014) showed 

that downslope transport rates of sediment vary due to varying soil thickness and slope, 

which are attributed to the varying weatherability of the different lithologic strata in the 

Gabilan Mesa of California. These studies show the importance of lithologic influences 

outside of channels. Despite the empirical evidence from these studies, there remains a 

surprising lack of understanding of how measurable lithologic properties, such as bedrock 

strength or jointing/fracturing, quantitatively control channel slope or concavity.  

Selby (1980) developed an empirical, semi-quantitative system to evaluate 

geomorphic rock mass strength and the stability of bedrock slopes, including factors such 

as intact rock strength, weathering, groundwater flow, and the spacing, orientation, width 

and continuity of joints. Several other geomorphic studies have focused on bedrock slope 

stability, demonstrating that these properties can significantly influence morphology 

(Schmidt and Montgomery, 1995; Clarke and Burbank, 2011). Roy et al. (2016) explored 

the mechanical properties of rocks through landscape modeling, finding that mechanical 

heterogeneities can exert strong controls on both the rates and patterns of erosion.  
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Additional numerical modeling studies further explore variations in rock strength, but also 

investigate bedrock properties such bed thickness and bedding orientations, with results 

indicating that contrasts in these properties can generate changes in landscape form and 

can also impart significant spatial variations on erosion rates (Forte et al., 2016; Perne et 

al., 2016).  The complex interactions of varying rock properties within these models 

suggest that real world interactions are likely even more complex, possibly resulting in 

misleading erosion rates and model results for studies discounting these factors. I 

hypothesize that topographic metrics can be used to predict or infer some bedrock 

properties, such as erodibility, which are imbedded within the morphology of the 

landscape. I also hypothesize that channel profile shape is heavily influenced by the most 

resistant units, whose position in relation to weaker units can significantly affect 

morphology, resulting in variability among predicted relationships with topographic 

metrics. 

This thesis analyzes the relationship between channel morphology and bedrock 

lithology. First, I further consider the stream power erosion model and how the interplay 

of variables obfuscate the influence of lithology and bedrock properties.  Then I discuss 

the regional setting for this study, exploring how the geologic history, climate, tectonics, 

and variations in lithology make the Guadalupe Mountains an appropriate setting to study 

the effect of lithology on topography. To evaluate the enigmatic relationship between 

bedrock properties and the stream power law, I compare calculated steepness and concavity 

indices to the relative durability of mapped lithologic units. I then determine if these 

topographic measurements can serve as a predictor of bedrock properties and discuss in 

detail the spatial distribution and patterns of these metrics across the Guadalupe Mountains 

region. I investigate specific areas in the region where these relationships appear variable 

and perhaps different, in order to better understand complicating factors affecting the 
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channel morphology. Confounding factors such as spatial lithologic variations within 

mapped units, as well as interactions between units of softer and harder rock, offer potential 

explanations for variability.   
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THEORETICAL BACKGROUND 

 As discussed above, the stream power erosion law is often used to model some of 

the feedbacks involved in bedrock incision, in order to predict erosional patterns. The 

stream power erosion law is shown in equation 1: 

      
nm SKAE              (1) 

where (E) is the rate of erosion, (K) is bedrock erodibility, (A) is the contributing drainage 

area, and (S) is channel gradient or slope. Exponents m and n are often determined 

empirically. The contributing drainage area serves as a proxy for the discharge, which is 

assumed to scale with the size of the watershed (Sklar and Dietrich, 1998). It is important 

to note that many different properties are embedded within the erodibility term (K), 

including bedrock strength, which is considered a first-order control, but also 

weatherability and climate, channel-width scaling, and sediment load (Howard and Kerby, 

1983; Whipple and Tucker, 1999). In some numerical models, the value of K is empirically 

fit based on topography (Howard et al., 1994; Stock and Montgomery, 1999).  Despite the 

importance of rock strength, understanding the role of other properties within the erosion 

model remains a major task.   

For quantitative analysis and the study of longitudinal river profiles (Figure 2a), 

equation 1 can be rearranged to solve for slope, where gradient is expressed as a power law 

function of contributing drainage area: 

      
nm

s AkS /             (2) 

where ks = (E/K)1/n and represents the steepness index, which is the channel gradient 

normalized to the contributing drainage area (Wobus, Crosby, and Whipple, 2006). The 

value m/n can be evaluated from the slope of a regression line in log-log space and can be 
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rewritten to represent the shape or concavity of the stream (Sklar and Dietrich, 1998) as 

shown in equation 3:  

            
 AkS s                                              (3) 

where θ is the concavity index (Flint, 1974; Wobus et al., 2006), which is the measure of 

how slope changes longitudinally with drainage area (Wobus, Crosby, and Whipple, 2006).  

In many eroding landscapes, equation 3 is most applicable to drainage areas larger than 

roughly 0.1 to 5 km2, below which debris flows and landsliding may be more important 

than fluvial processes (Lague, 2014).  Since the setting of this study has relatively little 

tectonic activity or climatic variance, equation 3 can be used to explore lithologic 

influences on overall longitudinal form of river profiles. 

Normalized steepness indices (ksn), along with a common reference concavity index 

(θREF), allows for meaningful comparisons among channels within a region. The reference 

concavity is a representation of the general shape of stream profiles across the entire region 

and equation 4 shows the normalized version of Flint’s Law: 

                      
REFAkS sn


             (4) 

The normalized channel steepness index (ksn) is very sensitive to the reference concavity 

value (θREF) and in order to compare ksn values for different channels across the region, 

θREF must be fixed (Whipple and Tucker, 1999; Han et al., 2015). To find the most 

appropriate θREF value, the general shape of streams across the region were evaluated. For 

analysis, the logarithm of reach slope (S) and drainage area (A) are plotted against one 

another, creating what is commonly referred to as a slope-area plot (Figure 2b). To find 

concavity, we calculate the slope of the regression line fitted to the slope-area data in log-

log space. By taking the logarithm of equation 3, the terms become linear as shown in 

equation 5:   
)()()( skLogALogSLog 

              (5) 
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This linear equation follows the typical structure of y = mx +b, where log of slope is y, log 

of drainage area is x, θ represents slope (m), and log (ks) is the y-intercept (b) (Figure 2b). 

This analysis was completed for many streams across the region and the average regressed 

concavity (θREF) of approximately 0.34 was found. According to Whipple (2004), θREF 

values for bedrock channels often vary between roughly 0.3 – 1.2, with lower values often 

representing short, steep drainages or downstream increases in either incision rates or rock 

strength. With an appropriate θREF value, we can perform regression analysis on the slope-

area data to find values of normalized steepness indices (ksn) by taking the logarithm of 

equation 4 to make the terms linear:   

              
)()()( snREF kLogALogSLog 
         (6) 

where log of slope is y, log of drainage area is x, θREF = 0.34, and log (ksn) is the y-intercept 

(Figure 2b). Equation 6 can be used to fit distinct values of ksn along the channel profile by 

setting regression bounds manually, allowing for different segments of the stream to be 

fitted independently. Equation 5 is used to fit the distinct values of concavity along the 

profile. 
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Figure 2. (a) Longitudinal Stream Profile (b) Slope Area Plot, used for fitting ksn and concavity indices.  Four distinct sections 

of the profile are fitted in this example, giving four different values of ksn and concavity.   

 

 

a. 

b. 
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Normalized steepness is a useful metric for evaluating the role of lithology across 

the region because according to stream power relationships, we expect steeper channels to 

have higher shear stresses, thus faster erosion rates (Whipple and Tucker, 1999). Without 

other complicating factors, such as uplift or climate variability, we expect stronger 

lithologic units to be less erodible and to adjust to a steeper gradient than weaker units 

(Duvall et al., 2004; Jansen et al., 2010). This can be seen in figure 3a, which shows the 

expected form of the steady state hillslope in an environment with layered rocks of different 

erodibility. In this scenario, the channel slope of each unit is maintained according to 

strength and the more resistant unit has a higher ksn. Additionally, streams in steady state 

are expected to generally have concave-up morphologies (Snyder et al. 2000; Whipple, 

2004), but still maintain steeper slopes in the resistant units and lower slopes in the less 

resistant units above and below (Figure 3a). The changes in both steepness and concavity 

can be seen in the corresponding slope-area plot (Figure 3c). In this plot, the changes 

surrounding the resistant unit are obvious. The slope of this line represents the concavity 

and the concavity of the resistant unit is shown as lower than the weaker units for the steady 

state form. There could be a variety of options for the concavity of this unit, but given that 

convex reaches can represent a change in rock type when other factors are ruled out (Pike 

et al., 2010), a lower concavity seems more likely.  

This study aims to examine the changes in the longitudinal profiles of streams 

across the region, in hopes of quantifying the effects of erodibility of upon steepness and 

concavity. However, since real landscapes are not likely follow the steady state model 

outlined above, there could be substantial deviations from the expected channel form. 

Complex interactions of softer and harder beds could result in significant variations in 

steepness and concavity, as illustrated in figure 3b. When examining steepness in 

particular, I hypothesize that the effects of the resistant bed may be to steepen the 
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underlying weak unit, while the weak unit above becomes less steep (Figure 3b). Both 

responses can be attributed to the influence of the resistant bed, which “pins’ both upper 

and lower units in place as a consequence of geometry and reduced erosion rates of that 

resistant unit. This resistant unit provides a protective layer for underlying units, reducing 

their lateral retreat just below this contact. The mechanisms behind this steepening, likely 

due to sediment load, are discussed in detail in the discussion section. Alternatively, this 

resistant unit serves as a less erodible base level for the weaker upper units, limiting their 

downcutting.  

When examining the response of concavity alone, again, the units below and above 

respond differently (Figure 3b). Units below, will steepen just below the “pinned” contact, 

resulting in a more concave profile, while units above may weather away just above the 

“pinned” contact, resulting in more convexity and signifying a change in lithologic 

resistance. The expression of these responses is evident in the slope-area plot (Figure 3d), 

where the lower unit has a steeper slope and higher y-intercept, indicating both higher ksn 

and concavity. In contrast, the upper unit has a lower slope and y-intercept. This response, 

and many variations of it, was observed in many of the actual slope-area plots from the 

region (Figure 2b). These changes were quantified for across the region to discern if 

patterns exist and to what degree the deviations from steady state described above were 

present in this landscape.   
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Figure 3.  Longitudinal profile showing expected steepness/concavity of a steady state channel (a) and non-steady state channel 
(b) before and after erosion (red dashed line). Slope-Area plots showing how both steady state (c) and non-steady state 
(d) relationships would plot in log-log space. The slope of the line is concavity and the y-intercept is the steepness (ksn).   

a. b.

c. d.
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STUDY AREA 

The Guadalupe Mountains of western Texas and southern New Mexico represent a 

Permian reef complex and carbonate platform composed of primarily limestone and 

dolomite (King, 1948; Boyd, 1958). Elevation and relief increase to the south. The 

mountains are bounded by a fault-line escarpment to the west and by an exhumed reef 

escarpment and gypsum plains to the east (Hill, 1987).  The study area covers an area of 

approximately 1630 km2 (Figure 4). The highest point is located to the south at Guadalupe 

Peak with an elevation of approximately 2,667 m and the lowest point within the study area 

is about 1000 m and is in the lower relief northeastern section near Carlsbad Caverns, NM. 

Much of the study area is managed by the National Park Service, including both Carlsbad 

Caverns National Park and Guadalupe Mountains National Park, or by Lincoln National 

Forest, which stretches across the northwestern area of the region (Figure 4).  

The regional climate is semi-arid, with mild winters and warm summers. During 

Pleistocene time, climate was wetter and cooler (Hill, 1987). Today, the mean annual 

temperature is 17.2°C and annual precipitation averages 37.6 cm for Carlsbad Caverns Park 

and about 44.2 cm for the Guadalupe Mountains to the south, with most of that falling 

during the summer months (U.S. National Park Service). Though weather conditions can 

be more variable in the higher relief southern region, overall there is not strong climate 

gradient present.  The dramatic height of El Capitan above the surrounding desert is 

evidence of past uplift, which occurred in Miocene time (15 -5 Mya), though the region 

has been tectonically inactive in recent history (Hill, 1998). This lack of recent tectonic 

activity, along with the weak climate gradient, make the Guadalupe Mountains an ideal 

field site for isolating effects of rock properties on topography. 
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Figure 4.  Map illustrating the study area and the various parks that manage it. Variation 
in topography in region is apparent. The three major depositional environments 
are also represented: The Delaware Basin, The Reef, and The Northwestern Shelf.  

  

Delaware Basin 

Northwestern Shelf 

Reef 

Reef 

Reef 
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Throughout the Paleozoic era, this region was covered by a shallow sea and during 

the Permian approximately 10,000 feet of sediment accumulated as sand, shale, and 

limestone (Richey et al., 1985; Urbanczyk et al., 2001). Though the lithology in the 

Guadalupe Mountains is dominantly composed of carbonates, many mapped units also 

contain or primarily consist of sandstone, shale and evaporites, providing enough contrast 

to study the changes in channel gradient compared to rock type. The stratigraphy for the 

region and an illustration of the different reef deposits are shown in figure 5.  The rocks in 

the region can generally be divided into three facies: the Delaware Basin, Reef, and the 

Northwestern shelf (Hill, 1987; Figures 4, 5a). The Delaware Basin deposits consist 

primarily of sandstones, which are exposed in the south and east, just below the massive 

carbonate reef deposits. During the Permian, organic reef building began along the rim of 

the Delaware Basin, ultimately culminating in a great barrier reef (Boyd, 1958).  The build-

up of these thick reef deposits resulted in a steep-sided, large carbonate platform, which 

provided a buffer for incoming waves, resulting in a calmer lagoon-type environment on 

the carbonate shelf, behind the reef (Figures 4, 5b).  These deposits, representing much of 

the northwestern shelf deposits, are broad, thin-bedded limestones and mixed clastic 

deposits (Hayes, 1964). However, further to the northwest lies another type of reef deposit 

(Figure 5b). An abrupt change can be seen between the massive reef deposit to the south 

and the more thin-bedded shelf deposits to the northwest, which represent a ramp-style reef 

(Harris, 2005). It is important to note the differences in rock units from the northwest to 

southeast as the depositional setting will influence heterogeneity in the rock across the 

region (Figure 5a). The mapped lithologic units used for this study are shown in figure 6 

and described in Table 1. 
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Figure 5.  (a) Stratigraphy of the Delaware Basin, showing the basin to shelf transition 
(Modified from Scholle, 2002). Basin deposits are in yellow (including Pdc, Pds, 
and Pdb), Reef deposits are in blue (including Pc, Pcm, and Pg), and Shelf deposits 
are in pink (including Pt, Pya, Pcb, Pq, and Pgb). The lower units in gray include 
Pbv, Psh, and Pbl. The San Andres formation (Psal, Psau, and Psa) is not included 
in this figure. Please refer to Table 1 for more information on corresponding rock 
units.  (b) Schematic showing the different types of reef formation in the region 
(Modified from Nichols, 2009). The Ramped shelf matches the style along the 
margin of the northwestern shelf (Figure 4). The rimmed style reef corresponds the 
reefs highlighted in Figure 4 and in blue in the stratigraphic column above. 

a. 

b. 
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Figure 6.  Map of the lithology of the region. Rock unit descriptions are available in 
Table 1.   
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Table 1.  Rock unit abbreviations, names, descriptions, and RDR values. Unit descriptions were derived from various sources (King, 
1948; Boyd, 1958; Alnaji, 2002; USGS, 2017). Units are arranged in approximate stratigraphic order. Please refer to Appendix A, 
Figure 27 for the stratigraphic column.  

Rock 
unit

Name(s) Description
Evaporite (+1 
per unit)

Shale (+2 per 
unit)

Sandstone 
(+3 per unit)

Limestone or 
Dolomite (+4 
per unit)

Massive (+1) 
and thin or 

heterogeneit
y (‐1)

Number 
of rock 
types 

(divide)

RDR

Pcs Castile Formation Evaporites: Primarily Gypsum and Salt. 2 ‐1 2 0.50

Pt Tansill Formation
Dolomite with few thin beds of sand/silt. Grades to 

anhydrite and salt northward. 
1 3 4 ‐1 3 2.33

Pya Yates Formation

Gray and red sand with some dolomite/shale. Weathers 

to gentle slopes.  Three distinct beds of dolomite 

seperated by persistent beds of quartz sansdstone. 

2 6 4 ‐1 3 2.75

Pse
Seven Rivers Formation 

(evaporite facies)

Evaporite facies: Primarily Gypsum, but with some 

sandstone, shale, and dolomite.
1 2 3 4 ‐1 4 2.25

Pcb
Carlsbad Limestone + 

Seven Rivers Formation 

(carbonate facies)

Limestone combined with northern carbonate facies, 

which are thin‐bedded limestone and dolomite, 

transitioning into gypsum and red beds in NE. 

1 2 8 ‐1 4 2.50

Pq Queen Formation
Mostly sand with some dolomite (mostly 

bottom/middle), as well as anhydrite and salt. 
1 3 4 ‐1 3 2.33

Pgb Grayburg Formation
Dolomite to sandy dolomite with abundant sand and 

some anhydrite.
1 3 8 ‐1 4 2.75

Psa San Andres Limestone
Thick‐bedded limestone transitioning into crytalline 

dolomite to the NW. Some minor shales present. 
2 8 1 3 3.67

Psau
San Andres Limestone, 

upper member

Limestone with some anhydrite and red beds. Possible 

thick gypsum beds to the North.
1 2 4 ‐1 3 2.00

Psal
San Andres Limestone, 

lower cherty member

Basal member consisting of dense zone of dolomite. 

Includes medium‐to‐fine‐grained sandstones and 

siltstones to very fine‐grained sandstone and pisolitic‐

fenestral dolograinstones/wackestone. 

6 8 ‐1 4 3.25

Py Yeso Formation Dolomitic limestones with gypsiferous, gray shales. 1 2 4 3 2.33

Qs Quarternary Sediments

Includes both older and younger alluvial deposits 

ranging from silt‐size to gravel/cobbles and even some 

massive boulder size blocks of limestone (less 

common). Cemented in some places. 

2 2.00
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Table 1 (continued).  Unit descriptions were derived from various sources (King, 1948; Boyd, 1958; Alnaji, 2002; USGS, 2017).  

Rock 
unit

Name(s) Description
Evaporite (+1 
per unit)

Shale (+2 per 
unit)

Sandstone 
(+3 per unit)

Limestone or 
Dolomite (+4 
per unit)

Massive (+1) 
and thin or 

heterogeneit
y (‐1)

Number 
of rock 
types 

(divide)

RDR

Pcm
Capitan Limestone, 

massive (reef) member

Massive white limestones. Consists in part of compact 

light‐gray, cream‐colored, or white calcitic limestone 

associated with dolomitic limestones. 

4 1 5.00

Pc
Capitan Limestone 

(including breccia(reef‐

talus) member)

Thick‐Bedded or massive white limestones of reef 

facies. Includes brecciated member. Consists in part of 

compact light‐gray, cream‐colored, or white calcitic 

limestone associated with dolomitic limestones. 

4 1 5.00

Pcbss
Carlsbad Limestone, 

sandstone member

Mixture of carbonate and sands.
3 4 2 3.50

Pg Goat Seep Dolomite/LS

Thick‐bedded to massive dolomite/limestone; in part 

sandy. Similar to thick‐bedded limestones in the south, 

but different in age. Dolomite interfingers with the 

3 8 1 3 4.00

Pds
Sandstone tongue of 

Cherry Canyon 

Formation

Moderately resistant, indistinctly bedded, grayish 

orange, very fine grained, well‐sorted quartz sandstone 

with scattered irregular chert nodules. Abundant fossils.

3 1 4.00

Psh
Bone Spring Limestone 

(cutoff shaly member)

Shale and thin‐bedded limestone, eroded away 

completely in some portions. Limestone beds are 

separated by thin beds of black papery shale. 1‐inch‐

thick layers of black chert are common.

2 4 ‐1 2 2.50

Pbv
Bone Spring Limestone 

(Victorio Peak gray 

member)

Black limestones with some lighter‐colered beds. Thick‐

bedded. Some lower beds have numerous chert 

nodules, but upper beds (approx 2/3) do not. Upper 

4 1 5.00

Pbl
Bone Spring Limestone 

(black limestone beds)

Black limestone beds. Thin‐bedded limestone, in part 

shaly.
2 8 ‐1 3 3.00

Pdb Bell Canyon Formation

Primarily sandstone, with some thin, dark‐gray 

limestone beds. Consists of very thick sandstones, 

alternating with less thick limestones, and rather hard 

2 3 4 1 3 3.33

Pdc
Cherry Canyon 

Formation (all 

members)

It consists primarily of limestone with brownish, 

bituminous shales and some fine‐grained sandstones. 
2 3 4 3 3.00

Pdy
Brushy Canyon 

Formation 

 It consists primarily of thick, yellowish sandstones with 

rather distinct shale partings and is capped by massive 

yellow or brown ledges of coarser grain sandstone. 

Conglomerates at base. 

2 6 1 3 3.00
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METHODS 

REGRESSION ANALYSIS 

To calculate ksn and concavity, slope-area regression analysis was performed using 

ArcGIS and MatLab software (Whipple et al., 2007). This software extracts elevations, 

stream head locations, and flow accumulation data from 10m USGS Digital Elevation 

Models (DEMs), transforming it into data to be analyzed within MatLab. Charts used in 

the analysis include longitudinal stream profiles and slope-area data, which were used for 

the regression analysis (Figure 2). Equations 5 and 6, which are described in detail in the 

section above, were used to find concavity and steepness indices respectively. The crucial 

advantage of using this method was the ability to calculate individual steepness and 

concavity indices for different segments of the channel, quantifying how the profile 

changes spatially.  Indices for each stream were mapped in ArcGIS for spatial comparisons.  

SPATIAL AND STATISTICAL ANALYSIS 

 Lithologic units were adapted from National Park Service GIS data in shapefile 

format (NPS Geologic Resources Inventory Program, 2006 and 2007).  Both the Guadalupe 

Mountains and Carlsbad Caverns National Parks have published maps. However, some 

mapped bedrock units are inconsistent in places across the state line between New Mexico 

and Texas, requiring editing to make the transition of units across this divide continuous. 

Detailed methods of combining some mapped units for consistency across the area are 

included as Appendix A. Figure 6 shows the finalized lithologic map, and Table 1 provides 

unit descriptions. Normalized steepness and concavity indices were compared to mapped 

lithologic units across the region. In addition to the regressed steepness and concavity 

values, local relief was also calculated and compared to lithology. Software within ArcMap 

was used to calculate the spatial intersection of the mapped lithologic units and the metrics 
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listed above, resulting in tables of unique combinations of lithology paired with ksn, 

concavity, and relief. The resulting datasets can be divided by lithologic unit to make 

statistical comparisons, which are discussed below.  

RELATIVE DURABILITY RATING (RDR) 

 In addition to the spatial and statistical comparisons described above, I also 

compared the topographic metrics to the estimated erodibility of the rock units in this 

region. It would be difficult and time consuming to measure geomorphically-relevant field 

erodibility over a large area, especially considering the lithologic heterogeneity of this 

region, where many of the mapped units grade into one another due to the shelf-reef-basin 

transition (Figure 5a). Lacking direct measurements of geomorphic rock mass strength and 

other factors affecting erodibility, a semi-quantitative ranking system was developed to 

estimate the relative durability rating (RDR) of each rock unit. Though this rating is serving 

as a proxy for bedrock erodibility, larger values represent more resistant material, giving a 

relative measure of durability rather than erodibility.  

For this ranking system, a first order value of 1-4 was assigned to each rock type 

included in the description, with 1 representing the weakest rocks and 4 representing the 

hardest rocks.  A value of 1 was given to evaporites, which are weak and prone to 

dissolution. A value of 2 was assigned to shaley units, which are easily eroded. Sandstones 

were given a designation of 3 due to the presence of quartz particles. Finally, the least 

erodible lithologies in this region are interpreted to be limestone and dolomite layers, which 

were given a value of 4. Some of the layers are described as “massive” indicating very 

thick deposits. These thick deposits add to the durability of the unit, so a value of +1 is 

applied.  There are also units with layered beds that are described as quite thin, which 

would make them more erodible, so thin-bedded units were given a value of -1. Many of 

the descriptions included a large variety of rock types for a single unit, indicating 
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considerable heterogeneity. To account for this, unit descriptions that detailed a great 

number of rock types or indicated lateral spatial changes in lithology were also given a 

value of -1. Rock durability values were summed, including values for massive, thin, or 

heterogeneous, for each distinct unit. This summed value was then divided by the number 

of rock types present to get an average relative durability for that unit (Table 1).  For 

example, the Queen Formation (Pq) is described as mostly sandstone with some dolomite, 

as well as anhydrite and salt (Table 1). To calculate the RDR, a value of 3 is assigned for 

the sand, a value of 4 is assigned for the dolomite, and a value of 1 is assigned for the 

anhydrite/salt. A value of -1 was assigned to account for heterogeneity. The sum of these 

values is 7, which was then divided by the number units present (3) to get the RDR, which 

is 2.33.  Relative durability ratings for all units are listed in Table 1, alongside their 

descriptions. The spatial distribution of RDR values is shown in figure 7.  
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Figure 7.  Map of Relative Durability Rating (RDR) for the region. Values also listed in 
Table 1, along with rock unit names, descriptions, and calculation of RDR values. 
Figure 5a is colored to match the RDR ratings and provides nice visual arrangement 
of these units.   
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RESULTS 

 Channel topographic metrics, ksn and concavity, are compared to mapped lithologic 

units. Kruskal Wallis tests are performed to compare the distributions of each metric per 

mapped lithologic unit. Averaged values of ksn and concavity for each unit are then 

compared to RDR values in order to determine their predictive potential. This is completed 

through linear regression analysis and also through a non-parametric correlation using 

Kendall’s τ. Mean ksn and concavity for each unit are also compared to one another. Cluster 

analyses are presented, showing how groups of statistically high and low ksn and concavity 

values, independent of lithology, are spatially distributed across the region. Average relief 

per rock unit is also compared to ksn, concavity, and RDR, providing an additional 

topographic metric for evaluation.  

NORMALIZED STEEPNESS INDICES (KSN) 

 Normalized steepness indices (ksn) were calculated for 1050 total streams within 

the Guadalupe Mountains region (Figure 8). For each of the channels, reaches with similar 

slope-area scaling were manually fit to equation 6.  The fitting of different segments was 

done based on the slope-area data alone, without considering locations of lithologic 

contacts (Figure 2b). The overall mean and standard deviation (+/- 1 σ) for ksn was 8.96 +/- 

7.21 (Figure 9a).  The distribution of ksn values were also determined for the channel 

reaches falling within each of the 23 mapped lithologic units (Figure 6; 9b; Table 2). The 

largest and smallest average ksn belongs to the Victorio Peak member (Pbv; ksn = 21.36) 

and the Castile formation (Pcs; ksn = 2.52), respectively. The Bell Canyon formation (Pdb; 

ksn = 11.32) has the largest standard deviation (+/- 1σ) at 10.96 and the evaporite facies of 

the Seven Rivers Formation (Pse; ksn = 3.38) has the least variability with a standard 

deviation of only 1.48. It is important to note that lithologic units have varying sample 
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sizes, dependent upon the extent mapped within the study area. I performed a Kruskal 

Wallis hypothesis test to determine if the distributions are the same or whether any unit 

distributions were statistically and significantly different than the others. The Kruskal 

Wallis test demonstrates that at least one, but possibly several, of the ksn distributions are 

significantly different, indicating that bedrock lithology does influence channel steepness 

in the study area.  However, this test cannot identify which specific groups are dissimilar, 

warranting additional investigation.  

To determine the predictive quality of these topographic metrics, I compare the 

mean ksn, which is weighted by channel length, of each rock unit to its relative durability 

rating (RDR). The linear regression of the mean ksn and RDR for each lithologic unit gives 

an R2 value of 0.43 (p-value = 0.0006), indicating a moderate significant correlation (Figure 

10). To better understand the relationship between these values, a non-linear rank 

correlation coefficient was calculated. The distribution of ksn indicates that the data are not 

normally distributed (Figure 9), so a non-parametric test may be a more useful measure of 

correlation. Using the non-parametric Kendall’s Tau coefficient (τ), I determined the 

relationship between RDR and mean ksn by comparing the ranked values.  Kendall’s τ, 

which measures a correlation between 0.0 and 1.0, was 0.52 (p-value = 7.4675 x 10-4) for 

these variables, suggesting a statistically significant higher degree of correlation than the 

linear fit.  
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Table 2.  Mean ksn and concavity values for each rock type. Sample sizes, standard deviations, and standard errors are also reported. 

The mean relief (given in meters and evaluated using a 1500-m radius circular window) for each rock type is also included.  

 

 

 

Unit
Ksn Sample 

Size
Weighted Mean 

Ksn 
Ksn Standard 

Deviation (+/‐ 1 SD)
Ksn Standard Error 

(+/‐ 1 SE)
Concavity 
Sample Size

Weighted Mean 
Concavity 

Concavity Standard 
Deviation (+/‐ 1 SD)

Concavity Standard 
Error (+/‐ 1 SE)

Relief (1500m)

Pbl 41 15.09 8.55 1.34 41 1.47 2.25 0.35 641.4

Pbv 51 21.36 10.44 1.46 51 0.97 1.34 0.19 847.4

Pc 369 14.37 7.94 0.41 373 0.74 2.17 0.11 609.2

Pcb 781 6.89 5.07 0.18 784 0.19 1.15 0.04 344.5

Pcbss 46 8.65 4.38 0.65 45 0.32 0.79 0.12 489.6

Pcm 303 12.12 8.53 0.49 306 0.58 2.64 0.15 486.6

Pcs 95 2.52 1.50 0.15 94 0.61 1.13 0.12 75.8

Pdb 103 11.32 10.97 1.08 103 1.72 3.21 0.32 339.1

Pdc 62 12.18 5.96 0.76 62 0.76 3.96 0.50 354.9

Pds 51 15.41 8.63 1.21 53 1.49 1.88 0.26 635.6

Pdy 52 13.62 9.91 1.37 52 0.60 2.40 0.33 658.6

Pg 141 11.58 7.63 0.64 142 0.34 1.24 0.10 578.6

Pgb 708 4.50 3.58 0.13 718 0.08 0.94 0.03 179.1

Pq 378 4.71 3.50 0.18 382 0.37 0.85 0.04 217.1

Psa 86 10.33 7.01 0.76 86 0.57 1.59 0.17 364.9

Psal 74 11.33 6.15 0.71 74 0.00 10.00 1.16 360.6

Psau 312 4.51 5.55 0.31 313 0.15 0.98 0.06 174.2

Pse 42 3.38 1.48 0.23 43 0.33 0.28 0.04 175.6

Psh 36 19.41 7.61 1.27 36 0.82 0.87 0.15 782.1

Pt 248 4.71 4.70 0.30 253 ‐0.07 3.92 0.25 209.0

Py 35 11.09 5.44 0.92 35 1.82 2.40 0.41 514.7

Pya 472 5.07 5.93 0.27 475 0.17 2.97 0.14 276.4

Qs 550 7.08 5.42 0.23 553 1.27 1.54 0.07 224.5
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Figure 8.  Spatial distribution of steepness (ksn) and concavity across the region for 1050 streams. 
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Figure 9. (a) Total ksn distribution. (b) The ksn distribution per rock unit. Means are in 
ascending order.  Violin plots created using code developed by Hoffman (2015). 

a. 

b. 
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Figure 10.  Correlation of mean ksn and Relative Durability Rating (RDR). R2 and Kendall’s Tau coefficient included on chart. 
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CONCAVITY 

 Like ksn, concavity values for the region can be characterized by a single value for 

some shorter channels, but many were fitted with multiple values in order to track spatial 

changes (Figure 8). The overall mean and standard deviation (+/- 1 σ) for concavity values 

was 0.34 +/- 2.14. The total distribution, as well as the distribution of concavity for each 

rock unit, are displayed in Figure 11. Weighted mean concavity values, along with standard 

deviations and sample sizes, for each rock unit are displayed alongside ksn values in Table 

2. Concavity values, like ksn, were weighted by channel length.  The most negative average 

concavity value, which indicates this rock type was slightly convex, was within the Tansill 

formation (Pt; θ = -0.073) and the most positive value of concavity fell within the Bell 

Canyon sandstone (Pdb; θ = 1.72), respectively. The lower San Andres (Psal; θ = 0.001) 

unit has the largest standard deviation of 10.00 and the Queen formation (Pq; θ = 0.37) has 

the least variability with a standard deviation of only 0.85. I performed a Kruskal Wallis 

test for concavity results and like the ksn test, they show that at least one, but possibly 

several, of the distributions are significantly different. To determine the predictive potential 

of the concavity measurements, I compared the mean concavity for each rock unit to RDR. 

The linear regression for this relationship is displayed in Figure 12. This linear correlation 

gives an R2 value of 0.016, indicating a poor relationship. I also calculated the non-

parametric Kendall’s τ coefficient, which showed a slightly stronger correlation with a 

coefficient of 0.13, yet the p-value was large (p = 0.40) indicating the results are not 

statistically significant. The linear regression of ksn and concavity yield an R2 value of 0.25 

(p-value = 0.015) and a τ of 0.43 (p-value = 0.0035), which are statistically significant, 

indicating some degree of correlation, but not a particularly strong one (Figure 13).  
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Figure 11.  (a) Overall concavity Distribution. (b) Concavity distribution per rock unit. 
Means are in ascending order. Y-axis is set at 10 and -10, though there are few 
outliers beyond this point. Violin plots created using code by Hoffman (2015). 

a. 

b. 
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Figure 12.  Correlation of mean concavity and Relative Durability Rating (RDR). R2 and Kendall’s Tau coefficient included. 
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Figure 13.  Correlation of mean concavity and mean ksn. R2 and Kendall’s Tau coefficient included. 
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CLUSTER ANALYSES  

Cluster statistics are used to gain a better understanding of how ksn and concavity 

values may be spatially related or grouped.  Calculated clustering is independent of 

lithologic contact locations and calculations were completed using ArcGIS. Spatial cluster 

analysis was performed using inverse distance weighting, which assumes that nearby 

neighboring features have a larger influence on the computation for a target feature than 

features that are further away. The clustering analysis is based on Anselin’s Local Moran’s 

I statistics, which identifies local spatial clustering of high and low values. The analysis 

produces a spatial distribution of cluster types, which indicate clusters of high-high (HH) 

and low-low (LL) values, as well as high-low (HL) and low-high (LH) values. For example, 

for an HH value it simply means that the specific value for a given channel is high and is 

also surrounded by other channels with similarly high values. Statistically insignificant 

values are also indicated (INS). The spatial distribution of the results for both ksn and 

concavity are displayed in Figure 14. The clustering statistics demonstrate that many of the 

spatial patterns in ksn are statistically significant.  However, patterns of concavity may be 

less meaningful. 
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Figure 14.  Cluster analyses show high and low values for ksn and concavity. Values plotted as INS are insignificant.  
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COMPARISON TO RELIEF 

A map of relief for the region is shown is Figure 15. Relief was calculated using a 

1500-meter circular window in which the minimum elevation was subtracted from the 

maximum elevation. This distance was chosen in order to fully characterize the drainage 

divides in the region, where there is an average ridge-to-ridge distance of approximately 

1500 meters.  The relief of each unit was compared to RDR (Figure 16). The regression of 

the two gives an R2 of 0.43 (p-value = 0.0006) and a τ of 0.54 (p-value = 5.0515 x 10-4), 

indicating similar success for predicting RDR as ksn. A comparison of mean ksn and relief 

is shown in Figure 17. The mean relief for each lithologic unit was calculated, excluding 

data outside of the main study area (Figure 4). Importantly, note that the relief was not only 

calculated along channels (as with ksn), but over the entire area of each lithologic unit. The 

linear regression in Figure 17 shows that the relief of each rock unit correlates well with 

mean ksn, giving an R2 0.89 (τ = 0.8; p-value = 1.36 x 10-11).  The linear correlation of 

concavity and mean relief was poor, with an R2 value of only 0.18. 
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Figure 15.  Map of relief, calculated using circular windows of 1500m radius. 
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Figure 16.  Correlation of mean relief and Relative Durability Rating (RDR). R2 and Kendall’s Tau coefficient included. 
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Figure 17.  Correlation of mean relief and mean ksn. R2 and Kendall’s Tau coefficient included  
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DISCUSSION 

The stream power erosion law is widely used as a straightforward method for 

modeling landscape evolution and studying various factors that control landscape form. 

However, the influence of bedrock properties and other factors that affect erodibility, while 

evident in landscape form, remains difficult to model accurately.  The goal of this study 

was to determine the relationship between bedrock properties, namely rock 

durability/erodibility, and topographic metrics such as steepness and concavity, which can 

be easily extracted from remotely sensed elevation data. In this section, I interpret the 

significant but relatively weak correlation between RDR and ksn to be influenced by the 

resistant reef deposits along the different locations of the carbonate platform margin. 

Additionally, I discuss how these resistant units, and the relative stacking of units of 

different durabilities, can affect channel form. Spatial relationships of ksn and concavity 

show that lithologic control exerted by resistant reef deposits heavily influences the shape 

of the channels in this region.  

NORMALIZED STEEPNESS INDICES (KSN)  

When steepness is differentiated by rock type (Table 2; Figure 9b), we see that 

standard deviations remain quite high, but that differences among the ksn of the units are 

obvious. In general, we expect that stronger lithologic units will exhibit higher steepness 

(Duvall et al., 2004; Jansen et al., 2010; Pike et al., 2010; Goode et al., 2010); however, 

the degree of lithologic control is not clear. The linear correlation of the two shows a 

moderate link between the measurements, which was expected, but certain rock units fall 

far outside of the relationship predicted by the linear fit (Figure 10). This indicates that 

lithologic strength is not the only factor affecting the steepness of the channel. The location 

of many of these atypical units within the stratigraphic framework suggest some degree of 
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lithologic control, which relates to the resistant reef deposits in the region, but does not 

directly correlate to the erodibility of a given unit.  The mapped quantiles of ksn, as well as 

the cluster analyses, show three areas of high ksn values (Figures 8, 14), which correspond 

to these locations:  The Southern Reef Rim (Zone 1), The North Central Reef Rim (Zone 

2), and The Algerita Escarpment and Last Chance Canyon, which are located at the 

Northwest Shelf and Margin (Zone 3) (Figure 18). These regions correspond to the two 

types of reef deposits, which formed on the platform margins (Figures 4, 6b). 
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Figure 18.  Focused study zones highlighting areas where stratigraphic relationships 
between resistant and more erodible units will be examined in detail. Key areas 
within the Northwestern Shelf and along the margin, namely The Algerita 
Escarpment and The Last Chance Canyon, are identified.  

 
  

Last Chance  
Canyon

Algerita  
Escarpment 

Southern 
Reef Rim 

Northwestern 
Shelf and Margin 

North 
Central Reef 
i



 

44

The Rimmed Reef Platform Margin 

The reef rim is the largest section of high ksn values and consists of units including 

the Capitan Limestone (Pc; RDR = 5.0), the massive deposits of the Capitan (Pcm; RDR 

5.0), and the Goat Seep Dolomite (Pg; RDR = 4.0). These resistant units are providing a 

source of lithologic control on weaker (lower RDR) units that are found both 

stratigraphically above and below. The weaker units along this reef rim display different 

geomorphic responses depending on their location in the stratigraphic column in 

comparison to the strong reef units. The weaker units to the south, which underlie the thick 

limestone reef rim deposits, display a higher than expected ksn (Figure 10). In contrast, the 

weaker units to the north, which sit atop the reef rim, display lower than expected ksn values 

(Figure 10). 

Zone 1 - Southern Reef Rim 

 Many of the beds showing over-steepened values are located to the south, within 

the Guadalupe Mountains National Park (Figure 4, 10 and 18).  The Cutoff shaley member 

(Psh), part of the Bone Spring Formation, stands out as a weaker rock in this region with a 

high ksn. The member, which consists of primarily shale, with some thin beds of black 

limestone and chert, was predicted to be less durable due to the high shale content (RDR = 

2.5). The regression line in Figure 10 would predict a corresponding steepness of 8.34.  

However, this unit has the second highest mean ksn of all units, at 19.41 (Table 2).  I 

interpret this high ksn is a consequence of the resistant Pg unit above, which is protecting 

the less durable shale unit from erosive processes. Moving further south, the Pbl, Pdy, and 

Pdc units are all identified as having similar durability (RDR = 3.0), but all fall well above 

the regression line in Figure 10. These units only outcrop in the southern region and are 

stratigraphically related, with Pdc on the top, followed by Pdy, and Pbl outcropping on the 

bottom (Figure 19a). El Capitan peak corresponds to an especially thick deposit of resistant 
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Pc limestone (RDR=5.0) directly above these units (Figure 19b). Like the Psh member to 

the west, the high steepness indices of these units could be explained by coarser sediments 

shed from the Capitan unit.  

In this same area, the Victorio Peak member (Pbv), which is also part of the Bone 

Spring Formation, displays the highest ksn in the entire study area.  Though the Pbv member 

was identified as one of the more durable rocks (RDR = 5.0), the mean steepness is 21.36, 

yet the predicted ksn is only 16.23 (Table 2; Figure 10). The Pbv member lies at the bottom 

of the stratigraphic sequence and the higher than expected ksn could be explained by 

mantling of coarse sediments from upstream units. 
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Figure 19 (a).  Map of ksn and Lithology at the Southern Reef Rim. 
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Figure 19 (b).  Map of ksn and RDR at the Southern Reef Rim. 
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Zone 2- North Central Reef Rim 

In the region just north of the TX-NM line up to Carlsbad Caverns National Park, 

many units display lower than expected ksn (Figure 10; 20). The Tansill formation (Pt) is 

the top-most rock exposed in this region and lies atop the Yates formation (Pya). The Pt 

formation consists of dolomite with thin beds of sand and silt (RDR=2.33).  The Pya 

formation is primarily sandstone with some dolomite and shale (RDR=2.75), and is said to 

weather to gentle slopes (Figure 20b) (Boyd, 1958; Alnaji, 2002). Both units display low 

ksn values and I suspect that this is due to the stronger limestone deposits (Pc and Pcm) 

which underlie them (Figure 20a). The Pcb (RDR = 2.5) unit to the west has a significantly 

lower RDR value than the Pc and Pcm units and represents a transition into the carbonate 

shelf, where the calm waters (protected by the reef) resulted in thinner, broader limestone 

deposits (Harris, 2005). This less resistant unit does not provide the same lithologic control 

or effect the stronger reef units do. The Pcb unit also has a relatively low ksn (Figure 10), 

but can likely be attributed to the depositional environment. This unit represents the 

Carlsbad limestone and was combined with carbonate facies of the Seven Rivers formation 

because alignment on the map and their similar lithologic descriptions (Figure 6; Table 1). 

However, there could be considerable lithologic heterogeneities due to the transition in 

depositional environment from south to north. 
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Figure 20 (a).  Map of ksn and Lithology at the North-Central Reef Rim. 
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Figure 20 (b).  Map of ksn and RDR at the North-Central Reef Rim.
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The Northwestern Shelf and Ramped Reef Platform Margin 

To the northwest, the shelf deposits are dominant and include the thin-bedded 

Carlsbad Limestone (Seven Rivers Formation), Grayburg, Queen, and Yeso formations 

(Figure 21a). The main reef deposit in this region is the San Andres formation, though there 

are three different mapped sections of the formation and each exhibit different durability 

ratings, and therefore may influence morphology somewhat differently (Figure 21b). Many 

of the deposits in the south grade into these units, signifying the transitional environment 

across the carbonate platform and adding complexity when trying to differentiate between 

units. However, uniform erodibility across a given mapped unit is assumed for this study. 

The San Andres limestone represents an example of a ramp-style platform margin, as 

opposed to the rimmed-style platform to the south and east (Harris 2005). Within this 

region, two areas of high ksn are present: The Algerita Escarpment and The Last Chance 

Canyon (Figure 18).  

Zone 3- The Algerita Escarpment and The Last Chance Canyon 

The Algerita Escarpment is a high relief area in the far northwest and The Last 

Chance Canyon is a small pocket of increased steepness located in central northern region 

(Figure 8; 14; 18). The stratigraphy exposed along the Algerita escarpment includes the 

San Andres formation (Psa), which splits into an upper (Psau) and lower member (Psal) to 

the northwest where they are underlain by the Yeso formation (Py) (Figure 21a). The Py 

unit was steeper than expected based on RDR (Figure 10). This formation is a dolomitic 

limestone with gypsiferous gray shales with the upper 600 ft. outcropped along the 

escarpment (Hayes, 1964). Though the upper San Andres limestone (Psau, RDR = 2.0) is 

not a particularly strong unit, the lower San Andres (Psal) has a moderate RDR at 3.25 

(Figure 21b).  Given it is rated stronger than the Yeso and also contains a fair amount chert 

(not accounted for in the RDR number), I interpret that this unit acts as a more resistant 
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cap rock, protecting the weaker Yeso formation below from downcutting near the contact 

between these units, while also potentially supplying coarse sediment that could mantle the 

bed.  

To the south, the Yeso formation pinches out and the escarpment stratigraphy is 

represented by the Grayburg (Pgb) formation overlying the San Andres (Psa). The Pgb 

(RDR = 2.75) is unit is weaker than the Psa (RDR = 3.67) unit, and though ksn values 

appear high for Psa, it does not plot above the regression line in Figure 10. The Grayburg 

formation, however, does exhibit low ksn (Figure 10), so the stronger Psa unit could be 

providing the resistant base need to support this softer formation.  

The lithology of the Last Chance Canyon is very similar to that of The Algerita 

Escarpment, except the bottom-exposed unit is the sandstone tongue of the Cherry Canyon 

formation (Pds), instead of the Yeso formation (Figure 21a). The Pds formation plots above 

the regression line (Figure 10), indicating a relatively steep unit. This steepness is apparent 

when looking at the mapped ksn values (Figure 8; 14). The Pds unit is present in the 

southern region as well and is said to grade laterally into the upper San Andres (Hayes, 

1964). The only area in the northwestern shelf where this unit is exposed, is within the Last 

Chance Canyon, where the unit is approximately 264 feet thick and consists of 

“…moderately resistant indistinctly bedded grayish-orange very fine grained well-sorted 

quartz sandstone with scattered irregular chert nodules and silicified megafossils.” (Hayes, 

1964). The moderate resistance of this bed (RDR = 4.0), produces an expectedly high ksn, 

and it is interesting to see the small cluster of high ksn given the surrounding topography 

and lithology (Figure 14; Figure 21). The low ksn Grayburg formation (Pgb), is atop the 

upper and lower San Andres (Psau and Psal), with the Pds unit on the very bottom. I 

interpret that the combination of the resistance provided by the Psal and Pds unit, are again 
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acting a supporting base for this softer formation, ultimately resulting in low gradient 

channels. 
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Figure 21 (a).  Map of ksn and Lithology at the Algerita Escarpment and the Last Chance Canyon. 
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Figure 21 (b).  Map of ksn and RDR at the Algerita Escarpment and the Last Chance Canyon. 
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In both the southern and northern regions of the Guadalupe Mountains, the more 

resistant reef deposits exert a clear control on the ksn of under- and over-lying units (Figure 

3b). In the case of higher ksn underlying the resistant units, I interpret the thick limestone 

and dolomite beds are acting as cap rock, simultaneously protecting the weaker beds from 

erosion and potentially providing a source of coarse sediment mantling the units below, 

which could result in over-steepening. The resistant units “pin” the units lying below, 

providing protection from the elements and limiting the lateral retreat of the more erodible 

rocks. This can result in the steepening of the unit, especially just below this contact point 

(Figure 3b). Additionally, as the more resistant unit weathers, the larger sediments could 

provide another form of protection via mantling of the bed. This theory works especially 

well for steep units with little exposed area, such as Psh and Pbv, as the resistant unit can 

over-steepen the entire unit through both mechanisms described.   

For the less resistant units on top that display lower than expected ksn, the resistant 

beds play a different role in this case, providing a strong base unit which provides support 

and sets the base level for lowering.  The resistant beds, in a similar fashion to the beds 

below, “pin” the upper beds in place, slowing the lateral retreat significantly (Figure 3b). 

However, in contrast to the units below the reefs, the units above are still exposed to 

weathering, resulting in thinner, weathered beds, which display lower gradients. As the 

weaker units weather laterally, this pinning effect of the resistant units can be compared to 

a base level. The stark contrast in erodibility of the stronger unit provides the lowest 

elevation the weak units can erode to, therefore setting the relief structure artificially low 

at these higher elevations, resulting in flatter beds (Figure 3b).  
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CONCAVITY 

Much like the ksn values discussed above, the average concavity value for the entire 

study area is also somewhat low, but still falls within the expected range for bedrock 

regions, which is typically between 0.3 to 1.2 (Whipple, 2004). The overall standard 

deviation is very high and represents the high variability of river profile shapes across the 

region, which could potentially be an effect of varying rock type. When concavity is 

grouped by rock type and compared to RDR, the standard deviations remain high, 

indicating large variation in profile form within individual units. This effect could still be 

a result of interactions between units of different durability, but the relationship is not as 

straightforward as ksn. Convex reaches represent deviations from the expected concave-up 

form and indicate some sort of perturbation (Pederson and Tressler, 2012).   When the 

concavity values for each rock unit are compared to the RDR, the linear correlation of the 

two variables is not statistically significant (p=0.56), and there is a lot of scatter among the 

data (Figure 12).  Unlike the mapped ksn quantiles, it is difficult to discern distinct regions 

or spatial patterns of high or low concavity (Figure 8). Cluster analyses confirm this (Figure 

14). However, many of the units far away from the regression line in figure 12 are 

neighboring rock units within different parts of the stratigraphic column. I surmise that the 

interactions of these beds are exerting control on the concavity, so I will frame the 

discussion by examining specific portions of the stratigraphy in various locations within 

the region. 

Zone 1- Southern Reef Rim 

To parallel the discussion of ksn, I will begin with units associated with the southern 

portion of the rimmed reef platform margin (Figure 5; 18). Units in in this area with higher 

concavity values include the black shaley limestone beds (Pbl), which also had 

anomalously high ksn, the Bell Canyon formation (Pdb), and the Cherry Canyon formation 
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(Pds) (Figure 12).  These units tend to outcrop at the bottom of the stratigraphic column 

beneath the more resistant reef deposits of Pg, Pc, and Pcm (Figure 22a). In this case, of 

weaker units under stronger units, I suggest the increased concavity in the weaker units 

could be due to increased coarse sediment supply from the stronger units above. Given this 

interpretation, we would also expect a moderately steep slope and this appears to be the 

case for these units with ksn values of 15.09, 11.32, and 15.41 for Pbl, Pdb, and Pds, 

respectively (Table 2). Other units in this region (Psh and Pbv) also have high values of 

ksn, but have lower concavity values, which fall closer to the linear trend (Figure 12). This 

could be due to their position within the stratigraphic column and the relatively small area 

of exposed bedrock for these units. These units do not lie under the very resistant Capitan 

Limestone, but rather the Goat Seep Dolomite (Figure 22 a and b). Perhaps this layer does 

not weather in the same manner, affecting how the sediment supply shapes the units below. 

Additionally, these outcrops are relatively small, so it can be difficult to get a good read of 

changes in longitudinal channel shape across such a short distance. 
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Figure 22 (a).  Map of concavity and Lithology at the Southern Reef Rim. 
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Figure 22 (b).  Map of concavity and RDR at the Southern Reef Rim. 
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Zone 2- North Central Reef Rim 

In the north-central reef rim, a different relationship can be observed.  Units Pt and 

Pya, as previously discussed, are both upper units of medium resistance. When examined 

more closely, both units exhibit going from lower concavity, or increased convexity, at 

their stream heads to higher concavity.  This is especially evident for the Tansill unit in 

Carlsbad Caverns National Park, showing convex reaches (highly negative values of 

concavity) at the top of the reef escarpment (Figure 23 a and b). In the area along this reef 

rim, these weaker upper units are held up by the thick, resistant reef deposits (Pc and Pcm), 

which limits downcutting of the units above. The resistant units lying directly below 

sometimes share a portion of the convex reach, but then transition to a higher concavity 

below this, indicating the change the in lithology from a less durable to a more resistant 

lithology, which also shows higher ksn. 
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Figure 23 (a).  Map of concavity and Lithology at the North-Central Reef Rim.   
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Figure 23 (b).  Map of concavity and RDR at the North-Central Reef Rim. 
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Zone 3- Northwestern Shelf and Margin 

In the northwestern area, regional concavities remain highly variable, but the 

Algerita Escarpment and Last Chance Canyon do appear to exhibit higher concavities 

comparatively (Figure 8; 14). Like the units associated with the reef rim, units appearing 

at the bottom of the stratigraphic column tend to display the highest concavity (Figure 24 

a and b). The Yeso formation (Py), which also displayed higher than expect ksn, exhibits 

high concavity also consistent with the interpretation that coarse sediment supply from the 

Psal unit (RDR = 3.5) is increasing incision and over-steepening at least a portion of this 

unit. The Psau and Psal units, which lie atop the Yeso, both exhibit lower concavities, much 

like the upper units in southern region (Figure 24b). In the Last Chance Canyon area, the 

Cherry Canyon Sandstone (Pds) and the lower San Andres (Psal) display high concavities. 

In this case, softer rocks (Pgb and Psau) are transitioning into the more resistant units, much 

like the examples on the north central reef rim (Figure 24b).  A similar morphology is 

displayed here, marking a stark transition from convexity to concavity with increasing 

durability.  
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Figure 24 (a).  Map of concavity and Lithology at the Algerita Escarpment and the Last Chance Canyon   
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Figure 24 (b).  Map of concavity and RDR at the Algerita Escarpment and the Last Chance Canyon. 
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There appear to be two processes affecting the concavity of rock types in this 

region, which depend partly on stratigraphic order and partly on RDR. The first process 

involves more durable units on top of more erodible units. In this case, the more durable 

unit supplies coarse sediment, which erodes the lower unit to a higher degree at and just 

below the contact (Figure 3b). The lower unit then tends to flatten out away from this 

contact, resulting in a classic concave-up form. This could occur if coarse sediment size 

and abundance were to decrease substantially downstream. Sediment size could decrease 

due to sediment particle abrasion in the upstream reaches where channel steepening occurs. 

However, it could also be an effect of size-dependent transport, where larger sediments 

mantle lower portions of the bed. Geometries created by “pinning” from the resistant units 

above could also play a role (Figure 3b).  

The second process occurs when more erodible units are on top of more resistant 

units, resulting in convex reaches and low ksn on top before transitioning into an area with 

high ksn and concavity. The upper less resistant units are limited by the resistant unit 

beneath, setting the base level for erosional processes (Figure 3b). However, the unit is still 

exposed weathering, resulting in relatively low relief beds. The stark elevation change at 

the edge of the contact can result in preferential weathering resulting in more convexity 

due to the transition from flat, low relief to a knickpoint (Figure 3b). An important aspect 

to note however, is that regardless of durability ordering within the column, whether the 

durable units are on top not, the more concave values always occur in the lower units. This 

relationship is likely why the RDR values and concavity do not show a strong correlation 

(Figure 12). When the resistant reef units, Pc/Pcm or Psa/Psal, are on top, they exhibit 

lower concavities, yet they exhibit higher concavity when on the bottom.  This could be 

due to concentrated weathering at the top of these units, which could occur if the weaker 

units above have retreated back from the contact point, exposing the top of the resistant 
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unit, which could result in rounding from the increased weathering. This makes it appears 

as if the concavity of a given rock unit is relatively independent of strength. The 

insensitivity of concavity to bedrock properties was predicted by Whipple and Tucker 

(1999) through non-dimensional analysis of the stream power law.   In this region, 

concavity depends more on its location within the exposed stratigraphic units, especially 

in relation to the strongest units within the region.  This indicates, much like ksn, that the 

most resistant reef units still exert some control for this metric. 

RELIEF 

Average local relief was calculated for each lithologic unit and the linear regression 

of relief and RDR values give a fair correlation (R2 =0.43; τ = 0.53), very similar to the 

correlation of RDR and ksn. Given that the correlation between relief and ksn is also strong 

(R2=0.89; τ = 0.8, Figure 17), this is not completely unexpected. The high correlation of 

mean ksn and relief is also expected, considering elevation changes are required to have a 

steep slope. However, relief is much easier to determine than ksn, and could provide an 

even quicker way to infer the erodibility of rock units. Work by Schmidt and Montgomery 

(1995) showed that relief was not limited by incision alone and could potentially serve as 

an indicator of landscape-scale material strength.  Units with the highest mean ksn values 

mostly outcrop in south, where the morphology is characterized by steep cliffs and 

therefore high relief. Other areas of high relief are along the reef rim, the Algerita 

Escarpment, and the Last Chance Canyon, which correspond to areas of high ksn, as 

indicated by the correlation above.  

LIMITATIONS AND FUTURE WORK 

Lithologic map resolution was adequate for this the scale of this study, but the lack 

of continuous units along the state line was a complicating factor. Some units were 

combined for continuity across state lines, which could impact the assumption of equal 
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erodibility across individual units. For example, the Carlsbad Limestone and the carbonate 

facies of the Seven Rivers Formation were combined into a single unit, Pcb, given their 

spatial relationship at the state line. However, there could be considerable lithologic 

differences given that this unit traverses the entire region. Additionally, bedrock was 

originally classified into mapped units in order to understand the stratigraphy and 

depositional environments, not rock properties. The issue of heterogeneity within the 

distinct rock units is also of some concern. Due to the nature of the depositional 

environment, many of the broader shelf deposits have significant heterogeneity, making 

interpretations more difficult in the transitional zones.   

For this study, beds were assumed to be primarily horizontal. However, a more 

detailed investigation into dips, of the beds could provide additional evidence for some of 

the results. Model results from Forte et al. (2016) show that even small changes in dip 

angles can have a large effect on erosion rates and landscape evolution. Strike and dip data 

are available within the National Park GIS files and future work will include a comparison 

of dip to ksn and concavity results. Faults and other structural features were not a focus of 

this study, but could be a potential factor, especially in the western escarpment of the 

southern Guadalupe Mountains where several NW-SE trending faults are present.  Another 

possible source of error, would be the potential variation in RDR values. For example, the 

Yeso formation, received a low strength value due to the gypsum and shale present, yet the 

dolomitic limestone may be the major influence (Table 1). A more detailed survey of past 

studies and rock composition could help to refine the RDR values and give better estimates 

to rock erodibility/durability.  

Field work verifying rock strength and fracture spacing could also provide more 

direct comparisons to bedrock properties. However, given the spatial scale of this project, 

and the variability in the rock across the region, that is not necessarily feasible.  However, 
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specific units and locations that represent deviations from the predicted relationship in 

figure 10 could studied more intensively, allowing a more detailed and focused study of 

the mechanisms and interpretations presented in this thesis. For example, outcrops in these 

areas could be characterized by the semi-quantitative Selby Rock Mass Strength system 

(Selby, 1980), which could provide more specific details of bedrock properties.  

Additionally, channels that exhibit high ksn or concavity be examined more closely, by 

evaluating the amount of bedrock exposure versus alluvial cover in the channels. Sediment 

size within channels could also be surveyed to assess the extent of coarse sediment abrasion 

and mantling of large resistant boulders. 

APPLICATIONS 

This method has a variety of potential applications. This method could be used to 

evaluate remote field sites or perform preliminary analyses prior to field studies. This could 

be especially helpful for studying the topography and rock properties of planetary bodies. 

We cannot yet conduct field studies on other planets, so we rely on remotely sensed data 

to complete research on planetary surfaces. This would work especially well on Mars 

considering the absence of modern climate and tectonic influences. Though multi-spectral 

scanners are used to remotely collect information from planetary surfaces, it can only 

provide chemical information of the rock types present. However, high-resolution 

topographic information is available for some locations, which could be used with this 

technique to predict other rock properties, such as erodibility/durability, which are 

imbedded in the topography. This information could provide additional information about 

these landscapes and lead to a greater understanding of how they are formed. 
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CONCLUSIONS 

 This study compares topographic metrics, normalized channel steepness (ksn), 

concavity, and relief, to the estimated relative durability ratings (RDRs) of mapped 

lithologic units, which serve as a proxy for bedrock properties such as durability or 

erodibility, showing that the correlation of ksn with RDR values demonstrate some degree 

of predictive power for that metric (R2 =0.43; τ = 0.52). The variability among these 

results can be explained by the influence of lithologic control exerted by more durable 

limestone and dolomite reef deposits in the Guadalupe Mountains region. I interpret that 

these reef deposits affect morphology in two ways: First, by serving as a cap rock and 

protecting units which underlie them, resulting in steep slopes and high ksn values for 

most of the lower units. Secondly, by providing a resistant base and supporting weaker 

units which lie on top, resulting in low ksn.    

In contrast, the correlation of concavity and RDR values gave a poor relationship 

(R2 =0.016; τ = 0.13), signifying poor predictive properties for that metric and possibly 

indicating that concavity is independent of rock erodibility. Despite this poor correlation, 

the influence of the resistant reef units can still be seen, typically resulting in higher 

concavity for units below the reefs and lower concavity, or higher convexity, for weak 

units atop the resistant units.  Resistant units displayed both low and high concavity 

values, complicating the relationship between this metric and rock erodibility, and further 

indicating that concavity may not be sensitive to strength in a simple or consistent 

manner.  

The results of this study show a quantifiable relationship between bedrock 

erodibility and channel steepness, offering insights into the stream power law that have 

yet to be fully explored in other studies. Model results and empirical data from previous 
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studies have demonstrated that more resistant units typically have higher steepnesses 

(Duvall et al., 2004; Jansen et al., 2010; Pike et al., 2010; Goode et al., 2010, Bursztyn et 

al., 2015, Forte et al., 2016; Perne et al., 2016).  These results confirm this, showing clear 

control of bedrock lithology on steepness, while also offering lithologic and stratigraphic 

interpretations for results that do not follow this convention, suggesting that the ordering 

of stronger and weaker units also matter. Though the relationship of RDR and concavity 

is not as straightforward, this thesis explores the possible sources of lithologic control 

affecting channel shape. These relationships provide valuable insight into lithologic 

control and concepts explored here could be applied to other settings or within landscape 

evolution modeling.  
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APPENDICES 

The purpose of these appendices are to provide additional figures and 

supplementary information on the study area, the spatial and statistical analyses, and 

detailed methodology within ArcGIS and MatLab.  
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APPENDIX A: ADDITIONAL FIGURES 

 
Figure 25.  Map of faults in the region. The effect of faulting and other structural 

components were not examined in this study.  
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Figure 26.  Precipitation map demonstrating the relatively mild climate gradient in the 
Guadalupe Mountains. Modified from Natural Resources Conservation Service 
National Water and Climate Center (2005).  
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Figure 27.  Stratigraphic column displaying units found in the region. Modified from Standen et al. (2009).  
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Figure 28.  Map displaying slope in the region.  
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Figure 29.  Correlation of mean slope and Relative Durability Rating (RDR). R2 included on chart. 
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APPENDIX B: DETAILED METHODOLOGY 

Data Collection  

Elevation Data 

USGS 10m Digital Elevation Models (DEMs) were downloaded from the National 
Elevation Dataset (http://ned.usgs.gov/). The “USGS NED n33w105 1/3 arc-second 2013 
1 x 1 degree ArcGrid” covers the northern extent or the New Mexico portion of the study 
area and the “USGS NED n32w105 1/3 arc-second 2013 1 x 1 degree ArcGrid” covers 
the southern extent or the Texas portion of the region (Figure 30). The DEMs are in 1/3 
arc-second resolution and were published in 2013, but last updated April 1, 2016. 
According to the metadata, the raster datasets are distributed in geographic coordinates in 
units of decimal degrees, and in conformance with the North American Datum of 1983 
(NAD 83). All elevation values are in meters and, over the continental United States, are 
referenced to the North American Vertical Datum of 1988 (NAVD 88). 

 

Figure 30.  National Elevation Dataset website showing study site and available USGS 
10m Digital Elevation Models (DEMs).  
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Geology Data 

Digital GIS layers detailing the geology of the region are available at the National Park 
Data Store (https://irma.nps.gov/DataStore/). Separate layers were downloaded for 
Guadalupe Mountains National Park and Carlsbad Caverns National Park. Both digital 
geologic maps were developed by Stephanie O'Meara (Colorado State University) as a 
component of the Geologic Resources Evaluation (GRE) program, a National Park 
Service (NPS) Inventory and Monitoring (I&M) funded program that is administered by 
the NPS Geologic Resources Division (GRD).  The Carlsbad Caverns geology map was 
published December, 8 2006 and the Guadalupe Mountains geology map was published 
January 29, 2007. The GIS data for both parks is available as coverage and table export 
(.E00) files, and as a shapefile (.SHP) and DBASEIV (.DBF) table files.  The GIS data 
projection is NAD83, UTM Zone 13N.   

 

Figure 31.  National Park Service Data Store website showing geospatial datasets 
available for download for the Guadalupe Mountains National Park (code 
GUMO). Data available for Carlsbad Caverns National Park can be found using 
code CAVE.  
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The National Park Service Describes the Datasets below:  

The data layers (feature classes) that comprise the Digital Geologic Map of Carlsbad 
Caverns National Park and Vicinity, New Mexico include: CAVEGLG (geologic units 
and contacts), CAVEFLT (geologic faults), CAVEATD (geologic attitude observation 
points), CAVELN (geologic contour and form lines), CAVEMIN (mine and mine related 
point features), and CAVESEC (cross section lines).  There are three additional ancillary 
map components, the Geologic Unit Information (CAVEGLG1) Table, the Source Map 
Information (CAVEMAP) Table, and the Map Help File (CAVEGLG.HLP).  

The data layers (feature classes) that comprise the Digital Geologic Map of Guadalupe 
Mountains National Park and Vicinity, Texas include: GUMOGLG (geologic units and 
contacts), GUMOFLT (geologic faults), GUMOATD (geologic attitude observation 
points), GUMOGLN (linear geologic units), GUMOGPT (point geologic units), 
GUMOSUR/GUMOSURA (surficial geologic units and contacts), GUMOMIN (mine 
and mine related point features), and GUMOSEC (cross section lines).  There are three 
additional ancillary map components, the Geologic Unit Information (GUMOGLG1) 
Table, the Source Map Information (GUMOMAP) Table and the Map Help File 
(GUMOGLG.HLP). 
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Stream Profiler Tool 

To calculate steepness indices, a stream profiler tool, developed in 2006 by Dr. Kelin 
Whipple and associates at MIT, was downloaded at 
http://web.mit.edu/gis/www/profiler_code/. This tool is designed to work in both ArcMap 
and MatLab and includes an ArcMap tool bar that can be added by customizing toolbar 
extensions, as well as several MatLab codes for processing and calculating steepness. 
Detailed instructions for installing and using the tool are available (Whipple, 2007).  The 
key advantage of using this tool is the ability to manually fit steepness indices for 
different segments of the longitudinal stream profile. This information can then be re-
imported into ArcMap as shapefile.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 32.  Profiler toolbar installed in ArcMap using Customize > Toolbars > 
Customize…, which brings up the window shown above (top). Check the box 
next to Profiler Toolbar and close window. Once installed, the toolbar will appear 
as above (bottom) showing options to Set Parameters, Select Points, Import 
Streams, etc.  
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Data Pre-Processing 

DEM Preparation 

To prepare the DEMs for stream profile analysis, several steps must first be completed 
and are also detailed within the stream profiler tool guide (Whipple, 2007).  

1. The 10m USGS DEMs are need to be in UTM coordinates for accurate analysis 
within MatLab. The original DEMs are in geographic coordinates in units of 
decimal degrees, and in conformance with the North American Datum of 1983 
(NAD 83). To change this, we must go to Data Management Tools > Projections 
and Transformations > Raster > Project Raster and enter the following options: 

a. The Output Coordinate system selected: NAD_1983_UTM_Zone_13N.  

b. Resampling Technique (optional): BILINEAR  

c. Output Cell Size (optional): 10 (Chosen to match 10m DEM cell size) 

Optional selections were chosen based on recommendations listed in the stream 
profiler guide (Whipple, 2007).  

2. Once projected, the two DEMs will need to be merged together to ensure 
continuous analysis, especially for streams that cross the state line boundary. To 
achieve this, we go to Data Management Tools > Raster > Mosaic to New Raster, 
input our projected rasters, and enter the following options: 

a. Pixel Type (optional): 31_BIT_FLOAT (Must match input raster data) 

b. Number of Bands: 1 

c. Mosaic Operator (optional): Blend  

d. Mosaic Colormap Mode (optional): Match 

3. The remaining DEM preparation steps can be computationally time consuming, 
so it is best to go ahead and clip the DEM to the area of interest to reduce this 
processing time. To clip the area of interest, a feature class clip polygon was 
created using the Editor toolbar. Once the polygon was created, the rasters were 
clipped using Spatial Analyst Tools > Extraction > Extract by Mask and 
specifying the polygon as the “Feature Mask Data.”   
 

4. Fill pits in the DEM. This step is completed to allow flow to escape depressions 
when completing the flow direction array (next step). This is competed by using 
Spatial Analyst Tools > Hydrology > Fill.  
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5. Create the Flow Direction Array. Use Spatial Analyst Tools > Hydrology > Flow 
Direction. Be sure to specify the filled DEM from the previous step as the input 
DEM.  
 

6. Create the Flow Accumulation Array. Use Spatial Analyst Tools > Hydrology > 
Flow Accumulation. Be sure to specify the flow direction array DEM from the 
previous step as the input DEM.  

a. Leave the Input weight raster (optional) blank 

b. IMPORTANT: Output data type must be specified as “INTEGER” 

7. Export Integer Flow Accumulation and unfilled DEM to ASCII files. These .txt 
outputs will be used in MatLab to extract channel profiles for analysis. Use 
Conversion Tools > From Raster > Raster to ASCII. NOTE: Be careful to follow 
naming conventions and keep files organized in their respective directories.  
 

8. Use MATLAB to convert the exported .txt files into .mat data files. This is 
completed within MatLab using the “arcdemtxt2matlab.m” code.  

After the DEM is prepared using the steps above, we can begin manually 
selecting streams within ArcMap for analysis.  
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ArcGIS Processing 

OBJECTIVE 1: CREATING REGIONAL STEEPNESS (ksn) SHAPEFILE 

1. Define Parameters for DEM Analysis 

a. Make sure the unfilled DEM is loaded and visible in ArcMap 

b. Select the “Set Parameters” button on the Stream Profiler Toolbar and 
specify parameters in the window (As seen in Figure 33 below):  

i. “Working Folder” 

Set to appropriate directories where ArcMap files can be stored.  

ii. Select unfilled DEM from the dropdown list 

iii. Choose project name 

This will save your settings in a file “projectname_parameters.txt” so you 
retain a record and can easily reload these settings with the “Import Saved 
Parameters” button at the top of the form 

iv. Choose and Set Theta Ref 

Typically, between 0.4 and 0.6, but was determined to be 0.34 for this 
region through preliminary analyses. 

v. Spike Remover 

Takes out any data spikes in your profile. Recommended for DEMs that 
had many pits to fill. 

vi. Step Remover 

Removes artifacts from USGS 10m DEMs, and allows no additional 
smoothing. 

vii. Smoothing Window 

The length of a moving average window over which MatLab will smooth 
raw profile data (in meters). Not needed if using Step Remover.  

viii. Contour Sampling Interval 

Interval is the vertical distance MatLab will use to calculate raw slopes 
(NOTE: 12.192m is equivalent to the 40ft contour interval most DEMs 
were created from). 
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ix. Auto_ksn Window 

The width of a moving window that MatLab uses to calculate normalized 
steepness indices along the entire length of a profile. 

x. Search Distance 

The distance MatLab will search downstream from your selected channel 
head (in pixels) to make sure it’s actually in the channel. The routine used 
to locate actual stream heads (and to eliminate the need to very carefully 
pick points selected in step 2 below) is as follows: (1) from your selected 
point the channel extractor runs downhill a number of pixels set by 
“Search Distance”; (2) the channel extractor then turns around and follows 
the channel all the way to the divide; (3) it then turns around again, 
moving downstream and begins data extraction (distance, elevation, 
drainage area) when it reaches the “Minimum Accumulation” (again in 
pixels) specified below. This way by picking anywhere near the channel of 
interest you can always extract exactly the same channel, and you can 
always start as near the divide as you like without needing to zoom way in 
when choosing your channel head position. 

xi. Minimum Accumulation 

Helps MatLab define where the actual channel head is: it is the number of 
pixels that contribute to the uppermost pixel in your channel 

After selecting parameters, be sure to save to file. Check that a new text file has 
been created called “run_parameters.txt”   
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Figure 33.  “Set Parameters” window. The settings displayed above were used for these 
analyses. 

 

2. Selecting Streams in ArcMap 

a. Before manually selecting streams it can be useful to add or 
manipulate layers to better visualize the stream network and topography 
and guide stream head selection. Suggestions are as follows: 

i. Reclassify the Flow Accumulation.  (Figure 34) 

ii. Create a shaded Relief Map (Figure 34) 
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Figure 34.  Reclassified Flow Accumulation and Hillshade for the study area to guide 
manual stream selection (1:350,000). Flow Accumulation was reclassified using 
1-5000 in order to produce the stream density above.  

 

b. Pick streams using Profiler toolbar. Select the toolbar button 
“Select Points” (See Figure 4). This will bring up crosshairs that can be 
used to locate which stream you would like to extract. This tool remains 
active until another ArcMap tool or another button on the Profiler Toolbar 
is selected. 

i. Use the cross-hairs to click near a channel head on your 
DEM. 

ii. Name and save point selection to text file by clicking 
“Submit Name.” The text file with saved locations will be called 
“location_ij.txt” Data format is [row column easting northing 
stream name]. 
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3. MatLab Processing 

After all streams are selected, the stream profile extraction and analysis in 
MatLab can begin. The main code used for this analysis is “profile51.m” and calls 
on several other stream profiler codes to produce results.  The MatLab codes 
generate two plots and step you through a series of analyses, where the most 
crucial step includes selecting a plot from which to pick regression limits, 
allowing for several fitted values of ksn to be calculated and saved. This process is 
described in detail in the Theoretical Background section.  

4. Return to ArcMap/Shapefile Creation 

Now back in ArcMap, we need to download the ksn data collected in MatLab in 
order to visualize it in ArcGIS and plot the data over the map.  

a. Use the Stream Profile Toolbar and select “Import Streams” to 
import ksn data as stream vector shapefiles. Each of the streams 
will be imported separately and downstream portions will have 
many overlapping lines. 

 

Figure 35.  Window used to import streams and convert to shapefiles after MatLab 
processing.  
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b. Use Data Management > General > Merge to combine all stream 
shapefiles into a single regional shapefile. This should be completed in 
batches depending on the number of stream shapefiles to be merged 
together.  

c. To better visualize results, it is recommended to change the 
Symbology to represent categories of steepness. To do this, right click on 
the shapefile layer and go to the Symbology Tab > Quantities > Graduated 
Colors. For Value field, select “ksn.” The classification method can be 
changed depending on the objective. Results of this analysis were 
symbolized using 10 Natural Breaks (Jenks) and then the “prediction” 
color ramp was applied. 
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